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Safety information
Important information

Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a
procedure.

The addition of either symbol to a "Danger" or "Warning" safety label
indicates that an electrical hazard exists which will result in personal
injury if the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please note
Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid
the hazards involved.
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Safety precautions
During installation or use of this software, pay attention to all safety messages that occur in the
software and that are included in the documentation. The following safety messages apply to
this software in its entirety.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Do not use the software for critical control or protection applications where human or
equipment safety relies on the operation of the control action.

• Do not use the software to control time-critical functions because communication delays
can occur between the time a control is initiated and when that action is applied.

• Do not use the software to control remote equipment without securing it with an authorized
access level, and without including a status object to provide feedback about the status of
the control operation.

Failure to follow these instructions can result in death or serious injury.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software, as this can lead to incorrect reports and/or data
results.

• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is
functioning correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of
communications links.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Introduction
The Hierarchy Configuration utility is intended for Application Engineers or advanced users
working with hierarchies in StruxureWare™PowerMonitoring Expert.

The utility is a command-line executable that allows you to save, restore, or add hierarchy
content.

The primary purpose of the utility is to give you a way to add a large number of entries to a
hierarchy rather than creating individual entries in Hierarchy Manager. This task consists of:

l Saving a skeleton hierarchy configuration in a CSV file.

l Editing the CSV file to associate the devices listed in the file to the nodes of the hier-
archy.

l Populating Hierarchy Manager with the updated contents of the hierarchy configuration
CSV file.

The utility also provides options for:

l Saving or replacing a hierarchy configuration currently defined in Hierarchy Manager.

l Installing or saving a hierarchy template.

l Refreshing a configuration cache to ensure that all devices are included when you save a
hierarchy configuration.

l Deleting a hierarchy configuration prior to restoring a saved configuration.

Throughout this document, references to "configuration" and "template" should be interpreted
as follows:

l configuration – the entries representing the node types, devices, and virtual meters that
comprise the content of a hierarchy.

l template – defines the node names, attributes, relationships, and views in Hierarchy Man-
ager.

Hierarchy Configuration utility command and options
Run the Hierarchy Configuration utility command, HierarchyConfig.exe, from a
Command Prompt.

To open a Command Prompt window:

1. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a 64-
bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a 32-bit
system.

2. Click the bin folder and press Shift + Right-click and select Open command window
here on the context menu.

The command syntax is:

HierarchyConfig.exe option <file path>\<file name>, where:

HierarchyConfiguration Guide Introduction
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l option: see "Command options" below.

l <file path>: the location of the file that the command runs on.

l <file name>: the name of the CSV or XML file, including the .csv or .xml file exten-
sion, respectively.

Command options
Use the command as follows (type the command and press Enter):

Running the command without options
l To see a brief description of available command options:

HierarchyConfig.exe

Running the command using the config option
l To create a skeleton configuration CSV file that you can use to define a hierarchy

configuration:

HierarchyConfig.exe export config <file path>\<file name>.csv

Note that this process creates a header row in the CSV file with percentage, node type
names, and virtual meter column headings. It also includes a list of the devices in the
system that are not included in a hierarchy. This allows you to specify which devices
you want to include in the hierarchy when you import the configuration.

Optional: Including all devices

Add the alldevices option at the end of the export config command to create a CSV
file that lists all of the devices, whether or not they are included in a hierarchy. This option
ensures that apportioned devices or devices that constitute a virtual meter are included in
the file.

To include all devices, type the following:

HierarchyConfig.exe export config <file path>\<file name>
alldevices

Note that the CSV file created with the alldevices option is intended for reference
purposes only and not for updating an existing hierarchy.

l To add the contents of the updated skeleton configuration CSV file to Hierarchy
Manager:

HierarchyConfig.exe import config <file path>\<file name>.csv



NOTICE
LOSS OF DATA
• Do not use the hierarchy configuration CSV file to incrementally update a hierarchy
in Hierarchy Manager.

• Use the Hierarchy Manager application to incrementally update an existing
hierarchy.

Failure to follow these instructions can result in the corruption of hierarchy
data.

Optional: Adding a timestamp to configuration entries

You can also add a timestamp to the configuration entries. Adding year, month, and day
information adds a start date to the imported references corresponding to the date
entered. If no date information is provided, the start date of the hierarchy information is
the system start date.

To add a timestamp, type HierarchyConfig.exe import config <file
path>\<file name> [yyyy/mm/dd] where [yyyy/mm/dd] is the year, month
and day that the imported hierarchy references use as a start date.

l To back up a complete representation of the hierarchy and all virtual meters in an XML
file:

HierarchyConfig.exe export config <file path>\<file name>.xml

This creates a backup of the hierarchy before youmodify the hierarchy entries in
Hierarchy Manager.

l To restore a hierarchy configuration from a backup configuration XML file:

HierarchyConfig.exe import config <file path>\<file name>.xml

NOTICE
LOSS OF DATA
• Do not use the hierarchy configuration XML file to incrementally update a hierarchy
in Hierarchy Manager.

• Use the Hierarchy Manager application to incrementally update an existing
hierarchy.

Failure to follow these instructions can result in the corruption of hierarchy
data.

This process deletes the current hierarchy configuration defined in Hierarchy Manager
and replaces it with the hierarchy configuration in the XML file.

l To refresh a configuration cache to ensure that all devices are included in the saved
configuration:

HierarchyConfig.exe refresh config

l To delete a hierarchy configuration:

HierarchyConfig.exe delete config

HierarchyConfiguration Guide Introduction
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Only use this process if you have previously saved your configuration.

Running the command using the template option
l To save the hierarchy template used in Hierarchy Manager:

HierarchyConfig.exe export template <file path>\<file name>.xml

The template defines the node names, attributes, and relationships used in Hierarchy
Manager.

l To replace an existing hierarchy template used in Hierarchy Manager with a different one:

HierarchyConfig.exe import template <file path>\<file name>.xml



Populating a hierarchy
After installing and commissioning PowerMonitoring Expert, you can populate Hierarchy
Manager by associating devices to nodes in a skeleton configuration CSV file and importing
the entries into Hierarchy Manager. Following a successful import, you can use Hierarchy
Manager to modify your hierarchy information. You can then use hierarchies in other Power
Monitoring Expert applications, such as in view-enabled reports in theWeb-based Reports
application, and in the Dashboards application.

For illustration purposes, the default hierarchy template in Hierarchy Manager is used as a
reference for this task.

The default hierarchy template defines nodes types, which include the labels (display names)
for the tabs in Hierarchy Manager.

The Tree View page for this hierarchy includes a physical layout view similar to the following
image. Note that you need to associate at least one device to an area to enable the site,
building, and area tree on the Tree View page.

HierarchyConfiguration Guide Populating a hierarchy
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The skeleton configuration CSV file created from the default hierarchy template used in
Hierarchy Manager includes a header row with column headings of Devices_Full Name, _
Percentage, Site_Name, Buildings_Name, Areas_Name, andVirtual Meter_Name. It
also includes a list of the devices in the system that are not included in a hierarchy so that
you can associate the devices to the hierarchy nodes.

A Header B Device List

Different hierarchy templates can be used in Hierarchy Manager. Each hierarchy template
determines the information that is included in the configuration CSV file. For example, the
Site Building Area Tenant.xml hierarchy template file results in column
headings of Devices_Full Name, _Percentage, Site_Name, Buildings_Name, Areas_
Name, Tenants_Name, Tenants_Contact, Tenants_email, Tenants_Phone, and
Virtual Meter_Name in the configuration CSV file.

(Sample and generic hierarchy templates are located in:

...\Applications\HierarchyManager\SampleTemplates folder in the Schneider Electric
install location.)

The procedure for updating a skeleton configuration CSV file follows a consistent pattern
regardless of the template used in Hierarchy Manager.

The process for adding a large number of entries to a hierarchy consists of:

l Saving a skeleton hierarchy configuration in a CSV file.

l Editing the CSV file.

l Updating Hierarchy Manager with the new entries and verifying the outcome.

NOTICE
LOSS OF DATA
• Do not use the hierarchy configuration CSV file to incrementally update a hierarchy in
Hierarchy Manager.

• Use the Hierarchy Manager application to incrementally update an existing hierarchy.

Failure to follow these instructions can result in the corruption of hierarchy data.



Editing and saving a localized version of a CSV file
If you edit and save a skeleton configuration CSV file that is created from a localized version
of Hierarchy Manager with Excel, the UTF-8 encoding in the file is not preserved. This results
in an unsuccessful update in Hierarchy Manager when you import the CSV file contents.

To resolve this situation, it is recommended that you use theGoogle Sheets spreadsheet
application. Editing and saving a skeleton configuration CSV file with Google Sheets
preserves the UTF-8 encoding, which results in a successful import of the CSV file contents
to Hierarchy Manager.

Before you begin
Before you export the skeleton configuration CSV file from Hierarchy Manager, make sure
that you complete the following tasks:

l Plan how the hierarchy is going to be configured, such as: naming conventions, which
devices are going to bemapped to which Node, and how the different elements are
grouped together. This can save time when you enter content in the configuration CSV
file and it is very important when dealing with a large number of devices.

For illustration purposes in this task, devices are going to bemapped to a physical layout
consisting of 4 areas within a building.

l Install Microsoft Excel, or another spreadsheet application that you can use to open and
edit CSV files on your system. (See "Editing and saving a localized version of a CSV
file" on page 13 for information about editing and saving a skeleton configuration CSV file
from a localized version of Hierarchy Manager.)

l Add devices, logical devices, and/or managed circuits to PowerMonitoring Expert using
Management Console. You can add additional devices at a later time, but you need to
have an initial number of devices before you export the skeleton configuration CSV file.
(See "Management Console" in theStruxureWare PowerMonitoring Expert 7.2 User
Guide for additional information regarding adding devices to PowerMonitoring Expert.)

HierarchyConfiguration Guide Populating a hierarchy
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Saving a hierarchy configuration in a CSV file
This process creates a skeleton hierarchy configuration CSV file with a header row that
includes percentage, node type names, and virtual meter column headings. It also includes a
list of the devices in the system that are not included in a hierarchy. This allows you to
specify which of those devices you want to include in the hierarchy when you import the
contents of the hierarchy configuration CSV file.

If devices have recently been added toManagement Console, use the refresh command to
update the configuration cache before proceeding. (See "Refreshing the hierarchy cache" on
page 26 for more information.)

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Type HierarchyConfig.exe export config <file path>\<file name>
and press Enter.

Where <file path> is the location for the exported CSV file, and <file name> is
the name of the file, including the .csv file extension. If you do not specify a file path,
the current directory is used.

NOTE: If you include spaces in the CSV file name and/or file path, youmust enclose the
file path and file name in quotationmarks. For example, HierarchyConfig.exe
export config "C:\test file.csv".

The items in the skeleton hierarchy configuration CSV file includes a list of devices not
included in a hierarchy, the heading _Percentage, headings for the node types, and the
headingVirtual Meter_Name.

A Header B Device List



Adding content to the configuration CSV file
The following steps describe:

l Defining themain elements (instances of a node) of the hierarchy.

l Associating devices to areas.

l Adding a virtual meters and associating devices.

Defining the main elements of the hierarchy
Define the site, building, and area names in the file as follows:

1. Open the hierarchy configuration CSV file in Excel.

2. On an empty row below the list of devices, type the names that you want to use for the
site, the building, and an area association in their respective columns.

As indicated in the previous description of the physical layout, there are 4 building areas.
You now need to define the association of the 3 remaining areas to the building and site.

3. Repeat the previous step for each of Area 2, Area 3 andArea 4, as shown in the
following image.

HierarchyConfiguration Guide Populating a hierarchy
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This completes the association of the 4 areas to the building instance, Building 1, and
the site instance, Test Site.

If there are additional buildings on the site, you can repeat the pattern that you entered.
For example, if there is a Building 2 on the site, your entries would include the same site
name, Test Site, but the building name is Building 2. Note that you should use unique
names for the areas. For example, forBuilding 2, define the area names likeB2-Area 1,
B2-Area 2, and so on.

Associating devices to areas
Complete the following steps to associate devices to specific areas:

1. Type the area name that you defined in the previous set of steps, in theAreas_Name
column on the row identifying the device full name.

For example, to associate device Test_Site.Test_8600_A toArea 1, typeArea 1 in the
Areas_Name column in that row.

2. Continue to associate any of the remaining devices to their respective areas. Note that



you can assignmultiple devices to the same area. For example, the following image
shows two devices assigned toArea 3 and two toArea 4.

Adding a virtual meter and associating devices
To define a virtual meter:

1. Type the virtual meter name in theVirtual Meter_Name column on the row identifying
each device full name that you want to associate with the virtual meter.

2. To apportion a percentage of a device's value to the virtual meter, type a percent value
for the applicable device in the _Percentage column. For example, apportion 25% of
Test_Site.Test_8600_C and 75% of Test_Site.Test_8600_D to virtual meterVM1.

HierarchyConfiguration Guide Populating a hierarchy
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3. To associate a virtual meter to a specific area, add the virtual meter name to the
Devices_Full Name column on a row defining the area. For example, to associateVM1
toArea 2, addVM1 to line 13 (in this example) in the CSV file.

You can also associate a virtual meter (VM1) to another virtual meter by including the
virtual meter name in theDevices_Full Name column and adding the additional virtual
meter name on the same row under theVirtual Meter_Name column.



When you complete your updates in the hierarchy configuration CSV file, you can now update
Hierarchy Manager by importing the contents of the CSV file.

Adding your entries to Hierarchy Manager
Complete the following steps to add the contents of the hierarchy configuration CSV file to
Hierarchy Manager:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Type HierarchyConfig.exe import config <file path>\<file name>
and press Enter.

Where <file path> is the location of the file you are importing, and <file name> is
the name of the file, including the .csv file extension. If you do not specify a file path,
the current directory is used.

The import process provides feedback during each stage of the import. If the import
operation is unsuccessful, the utility provides information about possible reasons for the
unsuccessful operation.

NOTE: If the CSV file name and/or file path contains spaces, youmust enclose the file
path and file name in quotationmarks. For example, HierarchyConfig.exe import
config "C:\test file.csv".

3. After you update the hierarchy with the contents of the configuration CSV file, verify that
the updates have been added as expected by opening the Hierarchy Manager application
from the Tools menu inManagement Console. See the Hierarchy Manager online help for
information about using the application.

HierarchyConfiguration Guide Populating a hierarchy
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Hierarchy Manager - Site tab

Hierarchy Manager - Buildings tab

Hierarchy Manager - Areas tab



Hierarchy Manager - Virtual Meter tab

Hierarchy Manager - Tree View

HierarchyConfiguration Guide Populating a hierarchy
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Saving and restoring a hierarchy configuration
The Hierarchy Configuration utility allows you to save (export) the configuration as an XML
file. The file contains a full representation of the current hierarchy in Hierarchy Manager,
including:

l Nodes.

l Relationships between nodes, including their time dimensions.

l All apportionment nodes.

This lets you back up the hierarchy beforemodifying it in the Hierarchy Manager application.
You can import the hierarchy configuration saved in the XML file to restore your hierarchy in
Hierarchy Manager.

NOTE: Restoring (importing) a configuration XML file deletes the current hierarchy
configuration and replaces it with the one represented in the file.

NOTICE
LOSS OF DATA
• Do not use the hierarchy configuration XML file to incrementally update a hierarchy in
Hierarchy Manager.

• Use the Hierarchy Manager application to incrementally update an existing hierarchy.

Failure to follow these instructions can result in the corruption of hierarchy data.

Saving the entire hierarchy configuration in an XML file
To save a configuration XML file:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Run HierarchyConfig.exe export config <file path>\<file name>,
where <file path> is the location where you want to save XML file, and <file
name> is the name of the XML file, including .xml as the file extension. If you do not
specify a file path, the current directory is used.

NOTE: If the XML file name and/or file path contains spaces, youmust enclose the file
path and file name in quotationmarks. For example, HierarchyConfig.exe export
config "C:\test file.xml".



Restoring the entire hierarchy configuration from an
XML file

NOTE: Restoring a configuration XML file deletes the current hierarchy configuration and
replaces it with the one represented in the file.

NOTICE
LOSS OF DATA
• Do not use the hierarchy configuration XML file to incrementally update a hierarchy in
Hierarchy Manager.

• Use the Hierarchy Manager application to incrementally update an existing hierarchy.

Failure to follow these instructions can result in the corruption of hierarchy data.

To restore the configuration XML file:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Type HierarchyConfig.exe import config <file path>\<file name>,
where <file path> is the location of the file you are importing, and <file name> is
the name of the XML file, including .xml as the file extension, to be imported. If you do
not specify a file path, the current directory is used.

3. After you import the configuration XML file content, verify that the content is what you
expect by opening the Hierarchy Manager application from the Tools menu inMan-
agement Console. See the Hierarchy Manager online help for information about using the
application.

HierarchyConfiguration Guide Saving and restoring a hierarchy configuration
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Installing or saving a hierarchy template
The import template command option lets you install a hierarchy template as a
replacement for the template used in Hierarchy Manager. The export template
command option lets you save a copy of the hierarchy template used in Hierarchy Manager.
Prior to using these commands, you should back up your existing hierarchy configuration
(see "Saving the entire hierarchy configuration in an XML file" on page 22).

Installing a hierarchy template
Use the import template option to replace the template currently installed in your system with
a different one.

NOTICE
LOSS OF DATA
The new template overwrites the existing template, which permanently removes all
information contained in the original. Export the existing hierarchy template from Power
Monitoring Expert before importing a new template.

Failure to follow these instructions can result in a loss of data.

When you import the hierarchy template XML file, the Hierarchy Configuration Utility
performs a validation test on the file. If the file validation is not successful, the utility does not
import the file and provides information indicating where the validation process stopped.
Check for any discrepancies in the file, save the changes and reimport the file.

To import a hierarchy template XML file:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Type HierarchyConfig.exe import template <file path>\<file
name>, where <file path> is the location of the XML file, and <file name> is the
name of the XML file, including .xml as the file extension, to be imported. If you do not
specify a file path, the current directory of the Hierarchy Configuration Utility is used.

The utility provides feedback for each stage of the import. If the import operation is
unsuccessful, the utility provides information about why the import is unsuccessful.

NOTE: If the XML file name and/or file path contains spaces, youmust enclose the file
path and file name in quotationmarks. For example, HierarchyConfig.exe import
template "C:\test file.xml.

3. Confirm that the template has been successfully imported by opening the Hierarchy



Manager application from the Tools menu inManagement Console.

Hierarchy Manager should now display the nodes defined in the newly imported
template. (See the Hierarchy Manager online help for information about using the
application.)

Saving a hierarchy template
Use the export template option to save the Hierarchy Manager template currently installed in
the system as an XML file. The file defines the node names, attributes, relationships, and
views for Hierarchy Manager.

To export a hierarchy template XML file:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Type HierarchyConfig.exe export template <file path>\<file
name>, where <file path> is the location where you want to save the XML file, and
<file name> is the name of the XML file, including .xml as the file extension. If you
do not specify a file path, the current directory is used.

NOTE: If the XML file name and/or file path contains spaces, youmust enclose the file
path and file name in quotationmarks. For example, HierarchyConfig.exe export
template "C:\test file.xml".

3. Navigate to the location you specified to confirm that the XML file is successfully saved.

HierarchyConfiguration Guide Installing or saving a hierarchy template

© 2015 Schneider Electric. All rights reserved. CONTROLLED DISTRIBUTION Page 25 of 40



Refreshing the hierarchy cache HierarchyConfiguration Guide

Page 26 of 40 CONTROLLED DISTRIBUTION © 2015 Schneider Electric. All rights reserved.

Refreshing the hierarchy cache
Use the refresh config option to refresh the configuration cache. If you recently added new
devices to PowerMonitoring Expert, use this command before you export a hierarchy
configuration CSV file so that an up-to-date list of devices is included in the file. If the refresh
configuration is not run, there is a possibility that devices recently added to PowerMonitoring
Expert may not be present in the device list in the hierarchy configuration CSV file. The best
practice is to run the refresh config command before exporting any CSV or XML file from
Hierarchy Manager.

To refresh the configuration cache:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Run HierarchyConfig.exe refresh config.

Themessage Configuration cache refresh complete indicates that the
refresh operation has finished.



Deleting hierarchy configuration content
Use the delete config option to remove all hierarchy configuration content from Hierarchy
Manager, such as names and properties. This allows you to start with new content. Note that
this delete process does not remove virtual meters. You need to use Hierarchy Manager to
delete virtual meters.

NOTICE
LOSS OF DATA
Performing this operation permanently removes configuration content from the system.
Ensure that this operation is necessary before proceeding. This procedure cannot be
undone.

Failure to follow these instructions can result in a loss of data.

To delete configuration content:

1. Open a Command Prompt window:
a. UseWindows Explorer to navigate to:

...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert\Applications on a
64-bit system,

or, ...\Program Files\Schneider Electric\PowerMonitoring Expert\Applications on a
32-bit system.

b. Click the bin folder and press Shift + Right-click and select Open command win-
dow here on the context menu.

2. Type HierarchyConfig.exe delete config. Type yes when prompted. The
utility deletes all hierarchy configuration content. To confirm the deletion, open Hierarchy
Manager. There should be no hierarchy content displayed.

HierarchyConfiguration Guide Deleting hierarchy configuration content
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Hierarchy template structure
PowerMonitoring Expert includes a number of standard hierarchy templates that provide a
structure for modeling the different aspects of your organization. This section describes the
structure of a hierarchy template XML file.

Sample and generic hierarchy templates are included with your software. You can use any of
these templates if they more closely represent the hierarchy organization you want to
implement. However, you need to have a thorough understanding of the structure of a
template beforemaking any changes. Always back up your files before proceeding with any
changes. The additional hierarchy templates are located in:

...\Applications\HierarchyManager\SampleTemplates folder in the Schneider Electric
install location.)

NOTE: Any time you change a hierarchy template, you need to import it into Hierarchy
Manager before those changes take effect. See "Installing or saving a hierarchy template" on
page 24.

Localizing a hierarchy template XML file
You can localize a hierarchy template XML file to display national language text on the tabs
and views in Hierarchy Manager, and also wherever hierarchies are enabled in theWeb
Applications component. For example, localized hierarchy node names will display in the
Source Selector in the Reports application.

To localize the text you need to edit the displayName attribute that is used throughout a
hierarchy template XML file. For example, the display name attribute for Site in the
hierarchy template file is displayName="Site". Change the text within the quotation
marks to the national language equivalent.

The displayName attribute is used in <Type>, <Attribute>, <Reference>, and <View>
xml elements in a hierarchy template file. (See "The XML elements in the template file" on
page 29 for descriptions of these elements.) In some cases the same text is used on
displayName attributes more than once in the hierarchy template file. Be sure to change
every occurrence in the file.

When you complete the edits, follow the process described in "Installing a hierarchy
template" on page 24 to update the hierarchy template used by Hierarchy Manager.

The hierarchy template
The hierarchy template XML file defines the Node types, attributes, and relationships used in
Hierarchy Manager. Each element of the template is defined using information contained
within the various XML tags. For example, assume that Generic 5 Level
Template.xml is imported into Hierarchy Manager. (See the "Generic 5 Level Template" on
page 36.)

The initial page in Hierarchy Manager shows the node types and attributes defined in the
hierarchy template file. The bottom three node types are configured for devices to be
connected to them.

(See "Additional notes" on page 34 for considerations related to associating devices tomore
that one node level in a hierarchy.)



The hierarchy view defined in the template is represented on the Hierarchy Manager Tree
View page as a physical layout:

The following table summarizes themajor elements in a hierarchy template XML file.

Tag Description Example

<Template> Contains template namespace
information

<Template version="1.0" xmlns="uri:application-
modules/power/model/template#">

<Types> Container tag for Type and
Attribute elements <Types></Types>

<Type>

Defineselements that define
characteristics used by the node .
Each type represents a tab in
HierarchyManager.

<Type displayName="level_1".../>

<Attribute> Defines the characteristics used
in each type.

<Attribute displayName="id" dataType="String"
uri="uri::application-modules/power/model/attribute#name"
/>

<Reference>

Used to create relationships
between nodes. For a
relationship to exist between
nodes, each Type element must
contain reference information for
every other element it is
associated with.

<Reference displayName="level_2" isReverse="true"
target="uri:application-modules/power/model/type#level_2"
uri="uri:application-modules/power/model/relation#1_2" />

<Views>

Containselements that define
how the Node typesare
presented in different hierarchical
views.

<Views></Views>

<View>
Specifies the node type the view
starts at. ContainsRelation
elements.

<View displayName="Generic Layout"
rootNodeTypeUri="uri:application-
modules/power/model/type#level_1">

<Relation>
Contained in a View element.
Defines the order that the node
typesare displayed in.

<Relation follow="uri:application-
modules/power/model/relation#1_2" reverse="true" />

The XML elements in the template file
This section describes each element in the template XML file.
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<Template>
The <Template> element is the container for all of the XML tags.

<Template version="1.0" xmlns="uri:application-modules/power/model/template#">

<Types>
This is a containment tag for all <Type> elements. Make sure any <Type> elements are
inside this containment tag.

<Types>
<Type...>
...
</Type>
...

</Types>

<Type>
The <Type> tag contains all the information required to define the Node. Each defined type
adds a tab in Hierarchy Manager. The tab name is defined by displayName. The <Type>
tag also contains one or more <Attribute> and <Reference> tags.

<Types>
<Type displayName="level_1" uri="uri:application-modules/power/model/type#level_1">

<Attribute... />
<Attribute... />
...
<Reference... />
...

</Type>
<Type>
...
</Type>

</Types>

To change the tab name in Hierarchy Manager from level_1 to new_name, modify
displayName in the template file from:

<Type displayName="level_1" uri= "uri:application-modules/power/model/type#level_1">

to:

<Type displayName="new_name" uri="uri:application-modules/power/model/type#new_name">

<Attribute>
The <Attribute> tag defines the characteristics of the <Type>. It uses dataType to
determine the format of the edit dialog that opens in Hierarchy Manager.

You need to define at least one <Attribute> element with attribute#name in the uri:

uri:application-modules.com/power/model/attribute#name.



The datatypes on the <Attribute> element can be such things as name, floor number, or
breaker ratings, depending on the template layout.

l dataType="String" - For short blocks of text (for example, name).

l dataType="LongText" - For long blocks of text (for example, notes, contact inform-
ation).

l dataType="Number" - For numeric fields (for example, breaker rating in Amps).

l dataType="Boolean" - For checkboxes (for example Rack Circuit).

<Types>
<Type displayName="level_1" uri="uri:application-modules/power/model/type#level_1">

<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/
model/attribute#name" />
<Attribute... />
...
<Reference... />
...

</Type>
<Type>
...
</Type>

</Types>

To add an attribute to a node, determine the characteristic you need to capture with that
attribute, determine the appropriate dataType, and create the attribute. To defineName as
one of the characteristics for a type, the Attribute tag is written as:

<Attribute displayName="Name" dataType="String" uri="uri:application-modules/power/model/
attribute#name" />

<Reference>
The <Reference> tag defines the relationship between types. To establish a relationship,
each <Type> element needs a <Reference> element, and each <Reference> element
needs to refer to the displayName of the related <Type>.

The following example contains references establishing a relationship between the <Type>
with displayName="level_1", and the <Type> with displayName="level_2".

Since the types are in a parent-child relationship, the reference in the child needs to contain
isReverse="true".

The last portion of the <Reference> element includes a relation name. It is used in the
Relation element within the <View> structure to define what appears on the Tree View
page in Hierarchy Manager.
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<Types>
<Type displayName="level_1" uri="uri:application-modules/power/model/type#level_1">

<Attribute displayName="id" dataType="String" uri="uri:application-modules/power
/model/attribute#name" />
<Attribute... />
...
<Reference displayName="level_2" uri="uri:applications-modules/power/model/
relation#1_2" target="uri:application-modules/power/model/type#level_2 />
...

</Type>
<Type displayName="level_2" uri="uri:application-modules/power/model/type#level_2">

<Attribute displayName="id" dataType="String" uri="uri:application-modules/
power/model/attribute#name" />
<Attribute... />
...
<Reference displayName="level_1" isReverse="true" uri="uri:applications-modules/
power/model/relation#1_2" target="uri:application-modules/power/model/
type#level_1 />
...

</Type>
</Types>

A physical or logical device, or managed circuit can be associated with any type.To configure
a type to connect with a device, create a Reference tag similar to the example below. Note
that meteredBy is a keyword, and it must be entered exactly as shown to correctly
reference a device.

<Reference displayName="device" uri="uri:application-modules/power/model/relation#meteredBy"
target="uri:application-modules/power/model/type#device" />

<Views>
This is a containment tag for all <View> elements. Views are themeans by which other
applications such as Dashboards and Reports discover the set of devices that are
aggregated together. All <View> elements need to be inside this containment tag.

<Types>
<Type...>
...
</Type>
<Type...>
...
</Type>

</Types>
<Views>

<View... >
</View>

</Views>



<View>
The <View> tag defines how a hierarchy can be viewed in PowerMonitoring Expert. These
different views provide different ways that a hierarchy can be displayed, or different ways the
device data associated with the hierarchy types can be grouped together.

The view displayName (for exampleGeneric Layout) is defined here. The name appears
on the Tree View page of Hierarchy Manager. You can select the view as a data source in the
Dashboards and Reports applications.

The <View> tag groups together the <Relation> elements whose order determines how
the view appears.

<Types>
<Type>
...
</Type>
<Type...>
...
</Type>

</Types>
<Views>

<View displayName="Generic Layout" rootNodeTypeUri="uri:application-modules/power/model/
type#level_1 >
<Relation... />
<Relation... />
...

</View>
</Views>

<Relation>
The <Relation> tag is used to establish how the different views of the hierarchy are
structured. The initial relation is defined in the <Reference> element within a <Type>.
Specify the node type to start at (the initial <Relation> entry), then add <Relation>
entries to complete the tree.

If a <View> element contains a <Relation> with reverse="true", then the view
presented follows the relationship in the reverse order.
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<Types>
<Type displayName="level_1" uri="uri:application-modules/power/model/type#level_1">

<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/
model/attribute#name" />
...
<Reference displayName="level_2" uri="uri:applications-modules/power/model/
relation#1_2" target="uri:application-modules/power/model/type#level_2 />

</Type>
<Type displayName="level_2" uri="uri:application-modules/power/model/type#level_2">

<Attribute displayName="id" dataType="String" uri="uri:application-modules/
power/model/attribute#name" />
<Attribute... />
...
<Reference displayName="level_1" isReverse="true" uri="uri:applications-modules/
power/model/relation#1_2" target="uri:application-modules/power/model/
type#level_1 />

</Type>
<Type...>
...
</Type>

</Types>
<Views>

<View displayName="Generic Layout" rootNodeTypeUri="uri:application-modules/power/model/
type#level_1 >
<Relation follow="uri:application-modules/power/model/relation#1_2" />
<Relation follow="uri:application-modules/power/model/relation#2_3" />
<Relation follow="uri:application-modules/power/model/relation#3_4" />
<Relation follow="uri:application-modules/power/model/relation#4_5" />
...

</View>
</Views>

Additional notes
Considerations when selecting a hierarchy view in a Web-
based report
If devices are associated with more than one node in a parent-child relationship in a hierarchy
tree, only those devices first encountered in the tree are included in generated reports. All
devices lower in the hierarchy tree are ignored in generated reports.

For example, if a hierarchy tree is structured as:

Site 1

Building 1 (including associated devices)

Area 1 (including associated devices)

and you select Building 1 on theViews page of theSource Selector in a report,



the generated report includes data for the devices associated withBuilding 1, but not for
devices in the lower node in the tree –Area 1.

Similarly, if you select Site 1, which does not include a device association in the hierarchy,
the generated report includes data for the devices associated with theBuilding 1 level only –
the level in the hierarchy where devices are first encountered.

Using comment tags
If you do not require all the levels provided in the example hierarchy template XML file, you
can comment out the types you do not need, from the bottom type up. Commenting out the
type, rather than just deleting the type preserves the structure of the template file and allows
you to reinstate the type with aminimum of effort. Enclose the <Type> element within the
start comment tag <!-- and the end comment tag --> to comment it out. For example:

<!-- <Type... >
...
</Type> -->

Remove the comment tags to restore the type.

If you want to remove one or more view elements defined in a template, add comment tags
around the applicable <View> tags. Remove the comment tags to restore the View
elements.

When you import the hierarchy template XML file, the Hierarchy Configuration utility performs
a validation test on the file. If the file validation is not successful, the utility does not import
the file and provides information indicating where the validation process stopped. Check for
any discrepancies in the file, save the changes and reimport the file.
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<Template version="1.0" xmlns="uri:application-modules/power/model/template#">

<!-- This is a template for a simple 5 level hierarchy. All the relationsand nodeshave been pre-configured. To
customize for your purposes, search and replace "level_1" with the name of your top-level type (e.g. Site),
...
"level_5" with the name of your lowest-level type (e.g. Room)
With this template you can attach "devices" to the lower 3 levels.
-->

<Types>

<Type displayName="level_1" uri="uri:application-modules/power/model/type#level_1">
<!-- everyTypemust have attribute#name - change displayName asneeded -->
<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/model/attribute#name" />
<!-- use these elements to add attributes to nodes -->
<Attribute displayName="string" dataType="String" uri="uri:application-modules/power/model/attribute#str" />
<Attribute displayName="notes" dataType="LongText" uri="uri:application-
modules/power/model/attribute#note" />
<Attribute displayName="number" dataType="Number" uri="uri:application-
modules/power/model/attribute#num" />
<Attribute displayName="boolean" dataType="Boolean" uri="uri:application-
modules/power/model/attribute#bool" />

<!-- this is how to create one half of the relationship between two nodes, you need a similar reference on the other
end of the relationship -->

<Reference displayName="level_2" uri="uri:application-modules/power/model/relation#1_2"
target="uri:application-modules/power/model/type#level_2" />
</Type>

<Type displayName="level_2" uri="uri:application-modules/power/model/type#level_2">
<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/model/attribute#name" />
<!-- this is the other end of the relationshipmarked above - isReverse is opposite, relation#... must be equal -->
<Reference displayName="level_1" isReverse="true" uri="uri:application-modules/power/model/relation#1_2"
target="uri:application-modules/power/model/type#level_1" />
<Reference displayName="level_3" uri="uri:application-modules/power/model/relation#2_3"
target="uri:application-modules/power/model/type#level_3" />
</Type>

<Type displayName="level_3" uri="uri:application-modules/power/model/type#level_3">
<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/model/attribute#name" />
<Reference displayName="level_2" isReverse="true" uri="uri:application-modules/power/model/relation#2_3"
target="uri:application-modules/power/model/type#level_2" />
<Reference displayName="level_4" uri="uri:application-modules/power/model/relation#3_4"
target="uri:application-modules/power/model/type#level_4" />
<Reference displayName="device" uri="uri:application-modules/power/model/relation#meteredBy"
target="uri:application-modules/power/model/type#device" />
</Type>

<Type displayName="level_4" uri="uri:application-modules/power/model/type#level_4">
<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/model/attribute#name" />
<Reference displayName="level_3" isReverse="true" uri="uri:application-modules/power/model/relation#3_4"
target="uri:application-modules/power/model/type#level_3" />
<Reference displayName="level_5" uri="uri:application-modules/power/model/relation#4_5"
target="uri:application-modules/power/model/type#level_5" />
<Reference displayName="device" uri="uri:application-modules/power/model/relation#meteredBy"
target="uri:application-modules/power/model/type#device" />

</Type>

Generic 5 Level Template



<Type displayName="level_5" uri="uri:application-modules/power/model/type#level_5">
<Attribute displayName="id" dataType="String" uri="uri:application-modules/power/model/attribute#name" />
<Reference displayName="level_4" isReverse="true" uri="uri:application-modules/power/model/relation#4_5"
target="uri:application-modules/power/model/type#level_4" />
<!-- this is how to connect up a logical/physical device to providemetered data to a node this can appear
anywhere in the hierarchye.g. mainmeter for building, metering points for specific loads, managed circuits for
multi-circuit monitors -->
<Reference displayName="device" uri="uri:application-modules/power/model/relation#meteredBy"
target="uri:application-modules/power/model/type#device" />
</Type>

</Types>

<Views>

<!-- View displayName showsup in the drop-down of Reports/Gadgets -->
<!-- specify the node type to start at, then add the relations to follow -->
<View displayName="Generic Layout" rootNodeTypeUri="uri:application-modules/power/model/type#level_1">
<Relation follow="uri:application-modules/power/model/relation#1_2" />
<Relation follow="uri:application-modules/power/model/relation#2_3" />
<Relation follow="uri:application-modules/power/model/relation#3_4" />
<Relation follow="uri:application-modules/power/model/relation#4_5" />
</View>

<!-- do not need to add the "meteredBy" relation in the View if a "meteredBy" relation hasamapped device no
matter what level of the hierarchy then the aggregation will return the value from themapped device -->
</Views>
</Template>
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